
 
Photoshop 7 

 
File Browser 
 
Photoshop 7 offers a new tool called the File Browser where files can be searched and opened 
visually rather than just by filename.   
 
The File Browser is located in the File menu, choose File, Browse.   
 
From the File Browser dialog box you will notice that a “tree” view of your hard drive is 
displayed.  Select a folder and the images in the folder will appear on the right-side of the dialog 
box. 
 
When an image is selected 
from the right-side of the 
dialog box a preview of the 
image will appear on the 
left-side of the dialog box 
beneath the “tree” view of  
your system.  
 
Information regarding the 
images is displayed beneath 
the image preview, such as 
filename, date created, 
image format and other 
information. 
 
The information displayed 
beneath the image preview provides much more information about the image than you see when 
using the File, Open method or when viewing the properties of an image.   
 
Double-click the image to open the image in its own window in Photoshop.  Note, you can also 
drag files from the file browser into the Photoshop main workspace where it will open in its own 
window. 
 
More Options with File Browser 
 
The File Browser can also be used for file management tasks such as, rename files, rename files 
in batch, rank files, remove rank, create a new folder, rotate image previews and several other 
options. 
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Option 1 – Context Sensitive Menu 
 
From the File Browser dialog box, right-click (click and hold for a MAC)  on a filename or 
image to reveal a context-sensitive menu.   
 
Explanation of the non-common menu options: 
 
Batch Rename – The Batch Rename menu option enables you to 
rename one or more images.  When the Batch Rename menu 
option is selected the following dialog box will appear for that 
feature. 

 
 
 
 
 
 
 
 
 
 
 

 
Rotation Options -  The Rotation options in the menu enable you to change the direction of the 
image preview in the File Browser dialog box.    
 
The rotation options available from the context-sensitive menu are applied while previewing the 
image in the File Browser and will also be applied to the actual image when the image has been 
opened.     
 
The following informational message appears 
when applying a rotation option to an image: 
 
 
 
 
 
Rank A,B,C,D,E – The Rank option enables you to rank images according to their importance 
and affects how they will appear in the File Browser dialog box.   
 
To apply a ranking on an image, right-click the image and select Rank A,B,C,D, or E from the 
menu.  Note, a Rank can be manually entered by first applying a rank such as, A, and then 
selecting the rank beneath the image preview and selecting it and typing in a rank of your choice.  
The Rank field will hold up to 15 characters, which can include numeric, alpha and character. 
 
Clear Ranking  - The Clear Ranking option removes any files that are ranked. 
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Option 2 – Sort By 
 
Located at the bottom of the File Browser dialog box, beneath the image 
previews, is a Sort By menu.  Display the Sort By pull-down list and select an 
option from the list as to how the files should be displayed in the File Browser 
dialog box. 
 
 
Option 3 – View By 
 
Located at the bottom of the File Browser dialog box, 
beneath the image previews and to the right of the Sort By menu is the 
View By menu.   Display the View By pull-down list and select an option 
from the list as to how the images should be displayed in the File Browser 
dialog box. 
 
 
 
The Healing Tool   
 

 
 

 
The Healing Tool is very similar to the Clone tool where parts of an image can be copied and 
applied to other areas on the image or different images. 
 
Start by selecting the Healing tool from the toolbox.  From the Options toolbar select a brush that 
fits the area to be copied.  Next, select an area that you want to copy and press Alt-click button 
(CTRL-Click Mac) to copy it.  Move the cursor to the area you want to copy to, left-click and 
drag the Healing tool over the area. 
 
Tip:  If you leave the Aligned option unchecked then every time you paint with the Healing 
brush it will repeatedly clone from the same place in the image, until you take a new sample for 
the tool. 
 
 
The Patch Tool   
 
The Patch tool is a great tool to use on old images that could have scratches or flaws.   
 
Start by selecting the Patch tool from the toolbox.  The Patch tool is located behind the Healing 
tool in the toolbox. 
 
When the Patch tool is selected the tool icon on the canvas changes to a lasso.   Depending on 
which option is selected in the Options bar, Source or Destination, you will either draw a 
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selection around a flawed area and drag it over to an area that should be used as a “patch” or vice 
versa. 
 
Source Option – When using the Source option, select an area that you want to modify, then 
drag the selection over to an area that you would like to use as a “patch”. 
 
Destination Option – When using the Destination option, select an area that you would like to 
use as a patch over an area that needs repair. 
 
 
Color Adjustment Commands  
 
If the overall color or contrast of an image is off then use either the Auto Levels, Auto Contrast 
or Auto Color commands.  These auto color and contrast commands will be applied to an entire 
image.   
 
The color adjustment commands are located in the Image Menu under Adjustments. 
 
Auto Levels – This command corrects an image that is too light or too dark. 
 
Auto Contrast – This command corrects an image that may be lacking in contrast and will 
further lighten light areas and darken dark areas.  A good image candidate for this command 
would be a washed out image. 
 
Auto Color – This command is great for those images that might have too much red or yellow or 
a color cast.  This command helps balance the colors in the image. 
 
 
Type Tool 
 
When adding a type layer to a canvas in Photoshop, it will be displayed in the Layers Palette on 
its own layer.  The layer name for the type layer will display as the actual text that is located on 
the type layer.  To rename the layer to a more meaningful name, Alt+double-click on the type 
layer and from the Layer Properties dialog box, type a new name.   
 
Paragraph Text 
 
Paragraphs of text can be added to an image by either typing the text directly onto the canvas or 
copying/pasting the text from an application, such as Microsoft Word.  Paragraph text appears in 
the Layers palette and looks and acts just like normal text added to a canvas.   
 
Start by selecting the Type tool from the toolbox and then with the mouse, left-click and draw a 
rectangle on the canvas, which will be used as the paragraph storage container.  The drawn box 
can be resized at any time by selecting one of the handles located on the sides of the box and 
dragging either in or out to the necessary size. 
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Formatting the Text 
 
Formatting paragraph text is made easy when using the Type tools in the Options bar.  Note, the 
Type tool must be selected in the tool box in order for the tools to appear in the Options bar.  
Formatting options can be chosen from the Options bar prior to typing text or typed text can be 
selected and then formatted. 

 
 
 

 
Text Size   
The size of the text can be changed at any time.  Select the type layer to be changed from the 
Layers Palette and select the Type tool from the toolbox.  Next, click and drag your cursor over 
the text to be changed, and select a different font size from the Font Size pull down menu.   
 
Text Color  
The color of the text can be changed at any time.  Select the type layer to be changed from the 
Layers Palette and select the Type tool from the toolbox.  Next, click and drag your cursor over 
the text to be changed, and select a different color from the Font Color icon located on the 
Options toolbar.     
 
 
Tip: It is difficult to see the change in the color of your text because of the highlight on the text 
selection.  Press the shortcut key Ctrl+H to toggle the highlight off/on for the selected text.   
 
Anti-Aliasing  
Anti-Aliasing, when applied, will smooth out the edges of text and blend the edge colors so that 
the text will not appear jagged.  Anti-Aliasing is recommended for web graphics that contain text 
larger than a 14 point size.  Anti-Aliasing is not required for text that is designed to “print” 
because the user is typically using a high resolution and the anti-aliasing is not required.  
However, for web graphics, experiment using the Strong, Crisp, and Smooth for type layers that 
are large than 14 points.  Applying anti-aliasing to text layers with a font size of less than 14 
points could cause the image to blur or be not as readable. 
 
Character and Paragraph Formatting 
More text formatting options can be 
displayed by selecting the Character and 
Paragraph icon that is located in the Options 
bar.   
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Kerning   
 
The Kerning tool is located in the Character Palette and adds spacing between two letters when 
applied.  To add kerning between two characters in your text layer, first position the cursor 
between two letters and next, choose a number from the Kerning pull-down menu or type a 
number in the Kerning field.     
 
Tip:  Kerning can also be applied without going through the Character Palette.  First, select the 
text layer in the Layers Palette.  Second, select the Type tool from the toolbox.  Third, position 
the cursor between the two characters in which you would like to apply kerning.  Last, press the 
Alt key + the left or right arrow keys to increase or decrease the kerning spacing. (Mac users, 
hold down the Option key + the left or right arrow key)  
 
 
Tracking  
The Tracking tool is located in the Character Palette and adds spacing between all the selected 
characters when applied.  The text must be selected when apply this tool.   
 
Tip:  Rasterizing Type  
A Photoshop warning box will appear when applying Filters to text layers.  The warning 
message will ask if you would like to rasterize the type.  When rasterizing the type in a text layer 
the layer will change to fixed pixels and will not allow text editing.    
 
Spell Check Text 
 
Photoshop pauses when it finds a possible error, and the word in question appears in the  
Check Spelling Dialog box.  If Photoshop questions a specialized 
term that is spelled correctly, choose the Add button to add the 
word to the current custom dictionary.  The next time you check 
spelling, Photoshop will not question the new term unless it is 
misspelled. 
 
Access the spell checker by choosing  Edit, Check Spelling.  
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Liquify Tools  
 
The Liquify tools in Photoshop are just fun tools to use.  The Liquify tools allow the user to 
warp, bloat, twirl, bend and any other unimaginable distortion you can think of and apply it to an 
image or part of an image.   
 
Access the Liquify tools by choosing, Filter, Liquify. 
 
Note:  the Liquify tools were located under the Image menu in Photoshop 6.    
 
Select any of the available tools in the Liquify toolbox, with the exception of the Freeze and 
Thaw tools, and drag, pull or push to distort the image.   
 
The Freeze tool can be used to protect part of an image from being distorted.   The “frozen” area 
of the image appears in a semi-transparent red color.  Use the Thaw tool to remove the semi-
transparent red color and to unprotect the selected portion of the image from distortion. 
 
 
Customizing and Saving Your Workspace 
 
Do you change your preferences when working with certain types of images?  Do you like to 
save your palettes in a certain location while working with specific images types?  With 
Photoshop 7 you can now save preferences and palette locations as a workspace.   
 
To save a workspace, choose Window, Workspace, Save Workspace and type a name for the 
workspace being saved. 
 
To load a workspace, choose Window, Workspace, and select one of the workspaces listed in the 
menu.     
 
To delete a workspace, choose Window, Workspace, Delete Workspace and select a name from 
the menu. 
 
 
 
 
 
 
 
 


